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Logging into the Student Portal and 

Home 

 

1. Follow the following steps to log in to the Student Portal: 
1.1. Navigate to the website by entering the correct web address into the browser of your choice.  

1.2. Once you have navigated to the site; the login screen will be displayed.  

1.3. Please enter the correct “Username” and “Password” into the login screen   and click the “Log 

in” button. 

1.4. Once you have logged in you will be presented with the dashboard as shown below. 

 

The Dashboard consists of eight tabs which are:  

Home, Registrations, Assessments, Extensions, Academics, References, Communication, Finance. 

 

 

 

 

 

 

 

 

 

 

 

 

 

The left side of the dashboard consists of Student information, MANCOSA Connect, Camera, 

Notification and Logout Icons. 

 

2. Home 

The Home tab consists of three screens: Home, My Profile and Log a Query. The Home Screen 

consists of a calendar in which you can see the number of events, assignments due dates, 

Holidays, Exam Dates so on. It also consists of information related to the Latest News, Notices 

and Public Holidays. 
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3.2 Contact Details: This screen consists of Contact Number, Email ID, Postal Address, Employer 

Address, Courier Address, Residential / Physical Address and Next of KIN contact details 

 

 

 

 

 

 

 

 

 

 

3.3 Change Password: You can change your password here.  
 

 

 

 

 

 

 

 

 

 

3. My Profile 

The profile screen consists of: 

3.1 Basic Information: This screen consists of Surname, First Name, Programme, Year of 

Programme and QR code. 

 

 

 

 

 

 

 

 

  

My Profile 
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4. Registrations 

The Registration tab consists of the following requests: 

4.1 Registration Requests 

4.2 DBA Registration 

4.3 Registration Change Request 

4.4 Change Bursary Request 

 

 

 

 

 

 

 

 

 

 

 

 

5. Registration Request 

The Registration requests screen allows you to raise a request based on the status and the request 

type. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Registrations and Registration Request 
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You will need to select the Status which is either In-progress, Approved or Rejected and then Request 

Type that is either a Deferral, Deregistration, Re-registration or Returning Registration then click on Raise 

New Request. 
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6. Deferrals 

Deferral screen helps the user to defer their studies for a specific year, semester or module which will 

then change the student’s status to deferred. 

 

 

 

 

 

 

 

 

 

 

 
This screen shows the following information: Intake, Learning Mode, Method of Teaching, Campus, 

Registration Number, Student Name, Programme and Year of Programme. 

After filling in the required fields, you will need to upload the required documents and click on the 

Save button in order for the deferral request to be sent for approval. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Deferrals 
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7. Deregistration 

The Deregistration screen allows the student to apply for a deregistration from the programme that 

they are currently registered for which, after approval, the student’s status will be changed to 

Deregistered. 

 

 

 

 

 

 

 

 

 

 

 
This screen shows the Intake, Learning Mode, Method of Teaching, Campus, Registration Number, 

Student Name, Programme, Year of Programme. You will need to provide the information related to 

the Document type, Description, Comments and then upload the required documents and click on 

the Save button to save the request. Once saved, the application will be sent for approval. 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

Deregistration 
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8. Re-Registration 

The Re-Registration request screen provides the current information of the student regarding their 

registration like the Intake, Learning Mode, Method of Teaching, Campus, Registration Number,  

Student Name, Programme, Year of Programme and the backlogged modules details. 

The Re-Registration Intake will auto populate for the student. The student will be required to provide 

the Payment Plan, Document Type and Description. 

 

 

 

 

 

 

 

 

 

 

 
The student will need to upload the required documents and save for the application to be approved. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Re-Registration 
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9. Returning Registration 

The Returning Registration request screen provides the information of Date of Request, Learning 

Mode, Registration to Tuitions, Method of Teaching, New Student Intake, New Structure Intake, 

Year of Programme, Student Type and so on. 

 

 

 

 

 

 

 

 
If it is a Bursary Application, then the student will need to provide the necessary information 

related to the Bursary Company. 

The student will see the details of the New Year Modules and the payment details such as 

Payment of Fee, Payment Method, Payment Plan and will be needed to provide Preferred day of 

Payment. 

 

 

 

 

 

 

 

 
Finally, the student will need to provide the Module Exemption Request details as shown below 

and then save so that the application can be sent for approval. 

 

 

 

 

 

 

Returning Registration 
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10. DBA 
 

This option will only appear for students that are eligible to apply for the DBA process. 

DBA-PR Registration (Pre-Registration) Request screen provides the information as per the 

image below. Fill in all the required details, Payment details and other details. Select the 

required check boxes and Terms and Conditions and submit the request. Enter OTP and send 

so that the application can be sent for approval. 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DBA 
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11. Registration Change Request 

 
The Registration Change Request is used to raise a request towards the registration change. 

 

 

 

 

 

 

 

 

 

 

 
This screen provides the registration information. For the request change the student will need to 

provide the change request type such as Programme, Elective Modules or Manage Exemptions. 

 

 

 

 

 

 

 

 

 

 

 
If the change request type is for a Programme, then the student will need to provide the details of 

New Learning Mode, New Method of Teaching, New Programme Structure Intake, New 

Programme, New Year of Programme, New Registration Option, Document Type, Description and 

Relevant Document. 

Select the required check boxes in Terms and Conditions and submit the request. Enter OTP and 

send so that it can go for approval. 

 

Registration Change Request 
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If the change request type is Elective Module, then it the screen below will reflect. 

Enter/Select the required data and select required modules from Programme Elective Modules as 

Per Structure (selected elective modules count should match with the elective group count) and 

then select the required check boxes under Terms and Conditions and submit the request. Enter 

OTP and send so that the request can be sent for approval. 

 

 

 

 

 

 

 

 

 

 

 
Finally if the change request type is Module Exemptions, then you be required to fill in the Exemption 

details such as the Module in Programme Applying, Institution Name, Completed Programme, 

Completed Module Name, Module NQF Level, % of marks obtained in Module and Course 

Completed. 
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 12. Change Bursary Request 

 
Change Bursary Request is also known as Bursary Pro-Forma Request. To raise the request, click on 

the Raise Bursary Request button. 

 

 

 

 

 

 

 

 

 

 

 

This Bursary request shows the information about the Registration Number, Registration Date, 

Student Name, Current Intake, Programme, Year of Programme, Email, Cell. 

 

 

 

 

 

 

 

 

 

 

 

Enter the required data and upload all the documents which are necessary and enter OTP The 

request will then be sent for approval.  

 

 

 

 

 

 

 

 

 

 

 

The student will be able to view the Bursary Information in the View functionality. 

Change Bursary Request 
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13. Assessments 

 

The Assessments tab consists of four following requests. 

14.1  OSA Script Request 

14.2  Aegrotat Request 

14.3  Upload Dissertation Documents 

14.4  Honours Coordinate Approvals 

 

 

 

 

 

 

 
 

14. OSA Script Request 

 
To raise the request, you can click on the raise new request tab as shown below and then 

provide all the required details. 

 

 

 

 

 

 

 
Fill in the details about the Year of Programme, Semester, Assessments Type, Module, Intake, 

Assessments Number, Evaluation Type and upload the Proof of Payment then click on Request. 

 
 

 

 

 

 

 

 

Assessments and OSA Script Request 
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15. Aegrotat Request 
 

To raise an Aegrotat Request, the student will need to select the request status, which is either:  

All, In-Progress, Approved or Rejected.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

After selecting the Request status click on the Raise New Request button the following screen will 

reflect. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Aegrotat details such as Registration, Intake, Student Name, Programme, Year of Programme, 

Date of Application will reflect. The student will need to provide some information about the 

Examination Type, Supplementary Examination Type, Reason For Application, comments and 

upload all the required documents. 

 

 

 

 

Aegrotat Request 
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The system will allow the student to select the required modules and raise a request and send it for 

approval 

 

Note: The student will only be allowed to raise a new request only when their modules have met 

the sub-minimum criteria for all the formative assessments. 

 

Students can view the Modules which did not get approved or have been rejected along with 

the comments. They can also raise the request for rejected modules or other based on the sub-

minimum criteria. 

 

 

16. Upload Dissertation Document 
 

This screen displays the list of uploaded dissertation documents with the Topic Title, Raised on, 

Status, Comments, Supervisor, Module and Deadline Date. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Upload Dissertation Document 
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On this screen, the student can Add Topic and send it for Approval once approved, student can 

add the proposal. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If Topic is approved with Amendment, the student can correct the topic and send for approval 

and if it is rejected, the student will be allowed to add Topic and send it for approval again.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once the Proposal is approved, the student will be able to add Chapter review and Status. In this 

stage they have an option to change their supervisor if required. The proposal will get approved 

by the Supervisor. 
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If the Proposal is Approved with Amendments, the student can correct the Proposal and send for 

approval and if it is rejected, the student will be allowed to add Proposal and send it for approval 

again. 

 

 

 

 

 

 

 

 

The student will be able to upload the related documents for chapter review and status. 

 

 

 

 

 

 

 

 

The student can view the uploaded documents related to Chapter Review and status by 

selecting the view option. 

Communication – The student can compose a message and send it to get a respone 

(this screen will be visible only when the Topic and Proposal is approved). 

 

 

 

 

 

 

 

 

Result – On this screen, student details are displayed along with the Registration Number, Student 

Name, Gender, Intake, Programme, Year of Programme, Module and Final Title. Once the results 

have been released, student will be able to view their final marks. 
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17. Honours Coordinator Approvals 
 

When the student sends the application, the application will need to be authoried by the 

supervisor. The supervisor then allocates the coordinator to the application for approval. 

 

18. Extensions 
 

The Extensions tab consists of three options: 

19.1 Apply for Honours Extension 

19.2 Dissertation Extension Request 

19.3 Private Tution 

 

 

 

 

 

 

 

Applying for Honours Extension can be done by Raising a new request by clicking on  

the Raise New Request tab. 

 

 

 

 

 

 

 

 

Honours Coordinator Approvals and 

Extensions 
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19. Dissertation Extension Requests 
 

This option allows the student to raise the extension request from the action column which will 

open the Extensiom Appeals form. This screen provides some details such as the Intake,  

Module Name, Date of Request, Review Option, Request Status, Dead Line and Review Status. 

 

 

 

 

 

 

The Extension Appeals form shows the student details. The student is required to fill in all the 

required details, click on Save and Next. 

 

 

 

 

 

 

The next step will be the Acknowledgement, where the students is required to add their initials and 

answers to the form – which needs to be short. On completition, click on Save and Next. 

 

 

 

 

 

Dissertation Extension Requests 
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The EXTENSION OF DISSERTATION SUBMISSION DEADLINE details will be displayed. This can be 

previewed as PDF and then saved. By doing this, the Extension Appeal Form will be Submitted 

Successfully.  

 

 

 

 

 

 

 

After being approved, the student will get an Extention Deadline Date under the Upload 

Dissertation Documents screen. 

Note: The extension due date is updated as per approval status. 

The Pro-forma Invoice and POP Upload functionality is available under Actions after approval 

• On the Pro-forma invoice, the student will be able to view the Extension details 

• On the POP upload, the student will be able to upload the required document and submit for 

approval. 
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20. Private Tuition 
 

Should the student require private tution, they can apply by raising a new request and provide 

the required details. 

 

 

 

 

 

 

Fill in the details for the Year of Programme, Semester, Module, Intake and upload the  

Proof of Payment and finally click on Request tab. 

 

 

 

 

 

 

 

 

 

 

 

21. Academics 
 

The Academic tab consists of eight topics which are: Academic Documents, Marks View, View 

all Transcripts, View all Documents, Badges, Honours Research Report Upload, DBA Topic and 

Proposal Submisssion and Graduvation RSVP. 

 

 

 

 

 

 

 

Private Tuition and Academics 
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22. Academic Documents 
 

On this screen, all the academic documents related to your programme reflects here which can 

be fitered based on the category and Sub-category as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

23. Marks View 
 

The Marks View screen consists of the information related to the Assignments, Projects, 

Examinations and Final Marks. 

 

 

 

 

 

 

 

24. View All Transcripts 

All the transcripts related to the programme with all the required information is available here. 

Academic Documents, Marks View and 

View All Transcripts 
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25. View All Documents 

View All Documents tab shows all the documents which are related to the programme and 

can be accessed by searching for the document. 

 

 

 

 

 

 

 

26. Honours Research Report Upload 

The student can view the report only when a supervisor is allocated to the request. 

All the details such as Assessment Intake, Programme, Module Name, Proposal Due Date, 

Research Report Due Date, Supervisor, Coordinator and Status reflects on this screen. 

 

27. Change Supervisor 

The student can request for change in supervisor and will be required to provide a reason for 

the request. The request may get accepted or rejeted based on the selected supervisor. If the 

request is rejected, the current supervisor will remain. 

 

28. Upload Proposal 

Uploading the proposal will only be allowed after the allocation of a supervisor. 

 

29. Communicate to Supervisor 

Here you can communicate with the supervisor regarding the uploaded proposal. 

 

View All Documents and Research 
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30. Proposal Upload History 

Here you will see the history of the supervisor approval, feedback and the status. 

 

31. Upload Final Proposal 

The upload of the Final Proposal will be done here. It will then be authorised by the supervisor. 

 

32. Upload Research Report 

Uploading of the Research Report will be done here, which will be authorized by the supervisor. 

 

33. Research Report Upload History 

Displays the history of all the reports uploaded, like Status, Date of Approval and Feedback. 

 

34. Upload Final Research Report 

The student will need to upload the Final Research Report here which will then be approved by 

the QA department. 

 

35. Submit to External Examiner 

Finally, the Research Report will be submitted to an external examiner to authorise. 

 

36. Download Supporting Documents 

Here you can download all the documents. 
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37. DBA Topic and Proposal Submission 

This option will only be displayed when a supevisor is allocated with the details such as Intake, 

Learning Mode, Method of Teaching, Programme, Module and Status. 

The student can Add the Document by choosing the option from the drop down and will  

need to submit it once the document is approved by the supervisor. Then only will the thesis be 

submitted. 

The entire project process can be viewed under the Project Process Report section as you are 

provided with the details of Approval, Feedback, Status and Date of approval. 

The View Project Progress Reports history shows the complete history of the Project progress. 

 

 

 

 

 

 

 

38. Graduation RSVP 

The Graduvation RSVP will display all the details about the Graduation Ceremony, which 

includes the Time of Graduation, Graduation Registration Start Date, Graduation Venue, Guest 

Admission and RSVP Link. 

 

 

 

 

 

DBA Topic and Proposal Submission 

and Graduation RSVP 
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This screen also explains all the process of the graduation ceremony and the conditions to 

follow which are: Important Notes, Protocol, details on the venue, MANCOSA Graduation Fair, 

and Frequently Asked Questions. 

 

 

 

 

 

 

 

The student is required to provide the RSVP details whether they will be attending or not. 

 

 

 

 

 

 

If the student is attending, he/she will to provide the following details such as whether there are 

guest attending, Title, Name and proof of payment if there are more than three guest 

attending. 
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If the student is not attending, he/she will need to provide the courier address and profile 

details so that the certificate can be couriered to them. 

 

 

 

 

 

 

39. References 

The References tab consists of two things: Add/View Second Hand Books and Journal View. 

 

 

 

 

 

 

The Add/View Second Hand Books displays the list of books with Subject name, Author Name, 

Publications, Book Title. 

 

 

 

 

 

References 
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Books can be searched by the Subject Name and Book Title. Where as the second hand book 

can be added by clicking on the Add Second Hands Books button. 

 

 

 

 

 

 

 

 View by clicking on the respetive View Icon. 

 

 

 

 

 

 

 

40. Communication 

The Communication tab consists six things which are: News, Notices, Announcements, 

Classroom and Workshop Attendence, Upcoming Events and Job. 

 

 

 

 

 

Communication 
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41. News 

All the latest Institution information and programmes will be available here. 

 

 

 

 

 

 

42. Notice 

The Notice board displays the information related to the Exams. 

 

 

 

 

 

 

43. Announcements 

Information related to the Institution and it’s programmes. 

 

 

 

 

 

News, Notice and Announcements 
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44. Upcoming Events 

This screen displays all the upcoming events with the Event Date and Event Name. 

 

 

 

 

 

 

 

 

Upcoming Events 


